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About 

Congratulations and thank you for using Dorico. 

This document lists all update changes, fixes and improvements as well as known 
issues and solutions for Dorico. 

Please note that the known issues and solutions section contains issues that might 
concern specific Dorico versions only. Please make sure to read through this 
section before contacting Steinberg support. 

Enjoy using Dorico! 

Your Steinberg team 
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Dorico 1.0.20 

December 2016 

This version contains the following improvements and issue resolutions. 

Improvements 

Performance improvements 

Building on the improvements in Dorico 1.0.10, this update includes further 
significant improvements to the performance and reliability of Print mode. For 
example, selecting multiple layouts in Print mode is now considerably faster. 
(STEAM-5386) 

Arpeggio signs 

A new Arpeggiation section has been added to the Ornaments panel in Write 
mode, allowing the creation of arpeggio signs indicating upwards and downwards 
arpeggiation, as well as a non arpeggio bracket line indicating that a chord should 
not be arpeggiated. 

To create an arpeggio sign on a chord in a single voice, select any notehead in the 
chord, and either select the desired arpeggio sign from the Ornaments panel, or 
type Shift+O to open the ornaments popover, in which you can type arp (or 
arpeggio) for an upwards arpeggio, arpdown (or arpeggiodown) for a 
downwards arpeggio, or nonarp (or nonarpeggio) for a non arpeggio sign. Dorico 
will create the arpeggio line spanning all of the notes in the chord. Dorico will not 
create an arpeggio sign if only a single note exists in the selected voice. Arpeggio 
signs can also be created during note input in chord mode using the ornaments 
popover. 

To create an arpeggio sign that spans chords in multiple voices (e.g. across both 
staves of a piano or harp instrument), select any notehead in the first voice, then 
hold Ctrl (Windows) or Command (Mac) and select any notehead in the second 
voice, then create the arpeggio sign either using the panel or the popover, as 
described above. 

Dorico will automatically adjust the length of the arpeggio sign as the pitches of the 
notes in the voices to which the sign belongs change, or as notes are added to or 
deleted from the chords, and will automatically delete the arpeggio sign when only 
a single note remains at that rhythmic position in that voice. 

By default, any grace notes at the same rhythmic position as an arpeggio sign will 
be positioned to the left of the arpeggio sign. To make the arpeggio sign appear to 
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the left of the grace notes, select the arpeggio sign and set the Arpeggio before 
grace notes property in the Properties panel. 

Downwards arpeggio signs have an arrowhead at the bottom of the line by default, 
but upwards arpeggio signs have no arrowhead by default. Arpeggio signs can 
alternatively show a Couperin-style swash at their top or bottom. To override an 
individual arpeggio sign, select it and open the Properties panel, then set the Sign 
end property. The length of arpeggio signs can also be adjusted on a case-by-
case basis in Engrave mode. 

Options controlling the default appearance of arpeggio signs have been added to 
the new Arpeggio Signs page of Engraving Options. 

Arpeggio signs do not yet have any effect in playback, but this is planned for a 
future update. 

Brackets and braces 

A new option Additional vertical protrusion beyond top or bottom of staff has 
been added to the Design group on the Brackets and Braces page of Engraving 
Options, allowing the thick vertical line of the bracket to be lengthened slightly if 
needed to ensure a good join with the chosen bracket tip glyphs in the current 
music font. (STEAM-5408) 

Instruments 

A keyless timpani instrument type, i.e. a timpani that does not use a key signature 
and instead shows accidentals for each note as required, has been added and can 
be chosen from the instrument picker. (STEAM-5339) 

Key commands 

 It is now possible to change the default key commands for changing the pitch of 
notes (Alt+up/down arrow to move by step, Shift+Alt+up/down arrow to move 
by chromatic step, and Ctrl+Alt+up/down arrow to move by octave). These 
commands can now be found in the NoteEdit category. (STEAM-5453) 

 It is also now possible to assign key commands for Edit ▸  Stem ▸  Force 

Stem Up, Force Stem Down and Remove Forced Stem. These commands 
can now be found in the Edit category. (STEAM-5454) 

Lyrics 

A new Italic property has been added to the Lyrics group in the Properties panel, 
allowing any non-italic lyric to be made italic if necessary, for example for 
occasional words in a different language, or vocalizations interspersed within the 
text. (STEAM-5404) 
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Music fonts 

Dorico now reads the JSON metadata files for SMuFL-compliant fonts from the 
locations recommended by the SMuFL specification: 

 Windows: C:\Program Files\Common Files\SMuFL\Fonts\ 
 Mac: /Library/Application Support/SMuFL/Fonts/ 

Dorico will load the JSON file if it is named fontname.json (e.g. Bravura.json) and 
located inside a folder called fontname (e.g. Bravura) in the appropriate path for 
the operating system. 

If Dorico can load the JSON metadata file correctly, then the font will appear in the 

list of available music fonts in Engrave ▸  Music Fonts. (STEAM-2290) 

Note input 

To create a time signature or key signature that applies only to the staff on which 
the caret is currently located, enter the time signature or key signature into the 
Shift+M or Shift+K popover as usual, and type Alt+Return (instead of Return 
alone) to confirm the item to be created. (STEAM-5422) 

Notes 

A new option Stem direction for notes on the middle line of the staff has been 
added to the Stems group on the Notes page of Engraving Options, allowing you 
to choose whether Dorico should use musical context (i.e. the staff positions of 
notes preceding and following the notes on the middle line of the staff) or a fixed 
default to determine the stem direction of notes on the middle line of the staff. 
(STEAM-5348) 

Ornaments 

A new option Horizontal gap between trill marking and trill extension line has 
been added to the Trills group on the Ornaments page of Engraving Options, 

allowing you to determine the distance between the  sign and the extension line 

to its right. 

Page layout 

A new Rastral size menu has been added to the Space Size group on the Page 
Setup page of Layout Options, allowing the specification of staff size according to 
the rastral sizes used in traditional music engraving. The largest size is Size 0 
(9.2mm or 0.36”), and the smallest size in Size 8 (3.7mm or 0.15”), and the default 
staff size in a new project is now Size 3 (7mm or 0.28”). It is naturally still possible 
to choose any custom size, as before, by editing the Space size value directly. 
(STEAM-5353) 

Two new options have been added to the Hide Empty Staves group on the 
Vertical Spacing page of Layout Options: 
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 Allow individual staves of multi-staff instruments to be hidden: When 
switched on, Dorico will allow (say) the left-hand staff of a piano instrument to 
be hidden on a system on which it has no music; when switched off, the piano 
will only be hidden on a system if both staves can be hidden. (STEAM-5382) 

 Players excluded from hide empty staves: This provides a list of all of the 
players in the current layout, and allows you to specify a list of players that 
should never be hidden, even if their staves are empty throughout a system. 
(STEAM-4755) 

Playback 

 A new Playback Options dialog has been added to the Play menu. This dialog 
contains options to determine how Dorico should interpret specific markings 
during playback, such as the percentage by which the written duration of notes 
should be extended under a slur or when encountering a legato playing 
technique, by how much the dynamic should be increased when playing an 
accent or marcato articulation, and so on. The dialog also includes an initial set 
of options for beat stress (the amount by which the dynamic should be 
increased on primary and secondary beats in the current meter) and for 
humanization of dynamic level and note start position. 

 Single- and multiple-note tremolos now play back. Measured single-note and all 
multiple-note tremolos are played back directly by rendering additional note 
events, while unmeasured single-note tremolos can be played back using 
unmeasured tremolo samples if they are provided by the VST Expression Map in 
use for the instrument. (STEAM-3904) 

 Slurs and the legato playing technique are now played back by extending the 
duration of all but the last note under a slur. (STEAM-5148) 

 Grace notes now play back. Any number of slashed and unslashed grace notes 
at present all play back immediately before the rhythmic note they precede, 
stealing time from the preceding rhythmic note. Playback of a single unslashed 
grace note, taking half the written duration of the rhythmic note that follows, and 
stealing time from that following rhythmic note, will be added in a future update. 

 A new option Show playhead when stopped has been added to the Play 
group on the General page of Preferences. When switched on, the playhead 
(vertical green line) will appear both during playback and when stopped; when 
switched off, the playhead will appear only during playback. (STEAM-4718) 

Preferences 

The General page of Preferences has been organized into groups of related 
options. 
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Rests 

A new option Bar rests in additional voices has been added to the new Rests in 
additional voices group on the Rests page of Notation Options. In new projects, 
this option is set to Omit bar rests, which means that when an additional voice 
(typically a down-stem voice) stops, any subsequent bars in which that voice has 
no notes or chords prior to its reappearance will not be padded with bar rests. This 
reduces the number of occasions you would have to search backwards through 
the music to set the Ends voice property on the last note in the voice, which might 
be dozens or even hundreds of bars earlier. 

If you would prefer that Dorico continue to pad all intervening bars with bar rests, 
set the new option to Show bar rests, which will also be the value chosen in any 
projects created in versions of Dorico earlier than 1.0.20. 

Furthermore, when this new option is set to Omit bar rests, bar rests no longer 
appear in bars where the only notes and chords present have been crossed from 
another staff. (STEAM-5212, STEAM-4831) 

In addition, a new option Allow dotted rests equal to the length of a compound 
beat has been added to the Compound Time Signatures group on the Rests 
page of Notation Options. When set to Allow dotted rests, a rest of a dotted 
quarter (dotted crotchet) in 6/8 will be rendered as a single dotted quarter rest; if it 
is set to Split at beat subdivisions, it will be rendered as a quarter (crotchet) rest 
followed by an eighth (quaver) rest. (STEAM-5109) 

Finally, it is now possible to create explicit bar rests during note input. Either click 
the new Insert Bar Rest button in the Bars and Barlines panel in Write mode, or 
type rest into the Shift+B popover. (STEAM-5036) 

Templates 

The Brass band template has been improved, with corrected staff labels for the 
cornet and horn instruments, and appropriate clefs for the trombones. (STEAM-
5334) 

Tempo 

It is now possible to control the appearance of absolute and gradual tempo 

changes independently in Engrave ▸  Font Styles. Absolute, relative and reset 

tempo markings use the Immediate tempo text font style, while gradual tempo 
changes used the Gradual tempo text font style. (STEAM-5387) 

Views 

When changing view type from galley view to page view, or vice versa, if there is a 
selection, Dorico now attempts to center the selected item or items in the new 
view. (STEAM-5025)   
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Issues resolved 
The following table lists all issues that have been resolved in this version: 

ID # Issue 

STEAM-5344 
Copy and paste: Notes within tuplets that have been created with Force Durations set now retain their 
forced duration when pasted. 

STEAM-5269 
Copy and paste: Using R to repeat a selection no longer sometimes pastes items (such as dynamics) in 
the wrong location. 

STEAM-5414 
Dynamics: Dynamics between the two staves of a keyboard instrument are now correctly centered. The 
option Allow dynamics between braced staves to violate minimum distance by n spaces has been 
removed from the Dynamics page of Engraving Options. 

STEAM-5403 
Holds and pauses: Caesuras at the end of a bar now cause multi-bar rests to break at the bar in which 
they appear, rather than at the following bar. 

STEAM-5391 
Holds and pauses: Caesuras that precede a change of time signature or key signature no longer cause 
the time or key signature to be spaced incorrectly relative to the barline. 

STEAM-5380 
Instrument changes: Items that apply to the whole system, such as tempo markings, rehearsal marks, etc., 
now appear correctly above the top staff when the top staff uses instrument changes. 

STEAM-5352 
Key signatures and accidentals: Setting a non-Western accidental on a note no longer incorrectly also 
sets the same accidental on the note in transposing layouts; now, the accidental is only set in transposing 
layouts if the relative offset between the concert and transposed pitch notes are identical. 

STEAM-5341 
Key signatures and accidentals: Notes with non-Western accidentals now behave correctly when 
repitched, and do not continue to show the same accidental even if the offset of the pitch changes. 

STEAM-5162 
Key signatures and accidentals: The rule that every tonality system must have an accidental type that fulfils 
the role of the natural (i.e. does not change the pitch) is now enforced, and it is no longer possible to 
delete any built-in accidental type, or any accidental type that is in use in the project. 

STEAM-5383 
Key signatures and accidentals: Accidentals types that contain graphics now display correctly in the 
Accidentals section of the Key signatures and accidentals panel in Write mode. 

STEAM-5347 

Key signatures and accidentals: The option Notes following a change of key signature that shows 
cancellation naturals on the Accidentals page of Notation Options now works as expected. This option 
only takes effect if Dorico will show cancellation naturals at a change of key, as determined by the two 
options immediately above this one in the dialog. 

STEAM-5338 
Key signatures and accidentals: A problem whereby instruments that don’t show a key signature (e.g. 
Horn in F) would under some circumstances not show the required accidentals on some notes in extreme 
keys (i.e. key signatures of 7 sharps or flats) has been fixed. 

STEAM-5264 
Key signatures and accidentals: Cancellation naturals now appear if necessary at changes of key arising 
from changing between instruments with different transpositions.  

STEAM-5192 
Key signatures and accidentals: Changes of key that occur in the middle of a bar now correctly take effect 
on the notes that follow the key signature before the end of the bar. 

STEAM-5274 
Key signatures and accidentals: When importing MusicXML files that use other accidentals than the 
standard 12-EDO or 24-EDO accidentals, Dorico now automatically creates an appropriate tonality 
system in the resulting project. 

STEAM-5426 Layouts: Custom layout names are now correctly preserved when re-opening saved projects. 
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ID # Issue 

STEAM-5255 
MusicXML import: Dorico no longer crashes when encountering a MusicXML file that specifies an invalid 
number for slur elements. 

STEAM-5074 
MusicXML import: Dorico no longer fails to open compressed MusicXML (.mxl) files that contain internal 
filenames that use extended Unicode characters. 

STEAM-5354 
Navigation: Using up/down arrow to navigate to the staff above/below from a selected bar rest no longer 
sometimes skips over the next staff. 

STEAM-5318 
Navigation: Using Ctrl+up/down arrow to navigate to the system above/below now works correctly, for 
any number of staves in the system. 

STEAM-3035 
Note input: Specifying that the next note to be input should explicitly be above or below the previous note 
now works more reliably. 

STEAM-5351 
Note input: Moving the caret to the staff above/below with up/down arrow now correctly takes into 
account whether the caret is at a tuplet position on the original staff, and moves to an appropriate position 
on the destination staff. 

STEAM-5430 
Note input: When inputting notes into transposing instruments in a transposing layout, notes are no longer 
sometimes input in successively higher octaves for no discernible reason. 

STEAM-5359 
Note spacing: Tempo markings are no longer considered when determining the width of multi-bar rests, 
unless another tempo marking in a later bar would collide with a previous tempo marking, preventing some 
multi-bar rests from being made much wider than necessary. 

STEAM-5402 
Notes: Augmentation dots are no longer hardwired to be drawn using Bravura, so if you choose to use 

another music font via Engrave ▸  Music Fonts, you will see the appropriate glyph from the new font. 

STEAM-5163 
Notes: Pairs of opposing voices where notes in both the left- and right-hand columns show an accidental 
on the same staff position, and where the note in the right-hand column closest to a note in the left-hand 
column is at an adjacent staff position, are no longer offset by an unexpectedly large distance. 

STEAM-4989 
Notes: Syncopated patterns of the form short-dotted long (e.g. quarter-dotted half in 4/4) are now 
notated according to the options set in Notation Options regardless of whether or not the dotted long 
note is also tied out of the bar. 

STEAM-5357 
Page layout: Changing the master page set of a layout on the Page Setup page of Layout Options is 
now reflected immediately in the display in the Master Pages section of the right-hand panel in Engrave 
mode. 

STEAM-5187 
Page layout: Under rare circumstances, staff labels would sometimes fail to update after undoing an edit 
that results in the point at which an instrument change occurs changing. This has now been resolved. 

STEAM-5287 Playback: Dynamics are no longer ignored during playback if the flow begins with a rest. 

STEAM-5394 Playback: Multiple dynamics on the same note are now played back more sensibly. 

STEAM-5369 Playback: Accents now play back correctly when notes with accents alternate with notes without accents. 

STEAM-5371 Playback: Playing techniques on the very first note of the flow now play back correctly. 

AD-269 
Playback: Typing Command-Q while a VST plug-in window is in focus no longer incorrectly quits the VST 
audio engine, resulting in Dorico itself hanging upon exit. 
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ID # Issue 

AD-253 
Playback: A problem whereby the VST audio engine could crash when used on a computer with on-board 
Realtek sound hardware has been fixed (Windows only). 

AD-260 
Playback: When reopening a saved project that uses Kontakt, a burst of static is no longer sometimes 
emitted as the project loads (Mac only). 

STEAM-5401 Rests: It is now possible to set properties, including the staff position, of bar rests correctly once more. 

STEAM-5356 
Selections: Edit ▸  Select All now selects only the music in the current flow, not across all flows in the 

project. 

STEAM-5385 
Slurs: Slurs are no longer temporarily incorrectly positioned if Edit ▸  Reset Appearance is invoked when 

both the slur itself and the notes at either end of the slur are selected. 

STEAM-5399 
Staff spacing: Using Alt+click-drag to drag a staff containing one or more instrument changes now works 
correctly. 

STEAM-5370 
Staff spacing: Copy Staff Spacing will now work even if the user has not made any adjustments to the 
staff spacing on the source page. 

STEAM-5406 
Text: Pasting text terminated by a null character (e.g. from a text block in Finale) into Dorico will no longer 
cause the project to become corrupted when saving. 

STEAM-4963 
Text: Changing the stretch for text in a text item or text frame now correctly changes the shape of the 
characters themselves, rather than merely the distance between characters (Mac only). 

STEAM-4971 
Text: Changing the stretch for text in a text item or text frame now displays correctly on screen and is 
reproduced correctly both when printing and when exporting PDF graphics (Windows only). 

STEAM-5358 
Text: Changing the point size of multiple selected paragraphs using the controls in the text editing 
popover now works correctly, rather than changing the size of only the first selected paragraph. 

STEAM-5434 
Text: The size of the text editor is no longer incorrect when editing a text item belonging to a staff that 
uses a non-default staff size. 

STEAM-5177 
Ties: When Tie endpoint positioning in chords is set to Outermost ties above/below noteheads, 
others between, Dorico no longer sometimes incorrectly offsets the wrong tie in multi-voice contexts. 

STEAM-5395 
User interface: Message boxes spawned from one of Dorico’s options dialogs no longer cause the 
options dialog itself to disappear behind the main project window (Windows only). 

STEAM-5381 
User interface: It is no longer possible under some circumstances to show more than one instance of the 
Layout Options or Notation Options dialog for a given score simultaneously. 

STEAM-5263 
User interface: The color picker dialog no longer increases in height slightly with each invocation within a 
session (Mac only). 

STEAM-5392 
User interface: It is no longer possible to click the various Save as Default buttons in the Layout Options 
and Notation Options dialogs when more than one layout or flow respectively is selected; being able to 
do this in earlier versions could result in the saved options data being incomplete or inconsistent. 

STEAM-4527 
User interface: Menu items that can be checked to show their state now correctly show the assigned key 
command, if any. 

STEAM-5393 
Dorico will no longer fail to start if the user’s saved layout options data is incomplete or inconsistent; 
instead, the data will simply be ignored. 
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ID # Issue 

STEAM-5360 
Dorico will no longer crash on start-up if it is unable to create the user’s chosen default project save 
folder. 
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Dorico 1.0.10 

November 2016 

This version contains the following improvements and issue resolutions. 

Improvements 
This maintenance update introduces the following improvements: 

Performance improvements 

 The speed of note input, and undoing note input, has been substantially 
increased. 

 The speed of changing the pitch of a selection of notes using Alt+up/down 
arrow has been substantially increased. 

 The speed of adding and removing players in Setup mode has been 
substantially increased. 

 Unnecessary screen redraws during editing operations have been eliminated, 
providing a substantial improvement in the speed of redraw during editing 
operations. 

 The speed of creating a new project from a template has been substantially 
increased. 

 The speed of entering and working within Print mode has been substantially 
increased. 

Articulations 

A new group of options Slurs on the Articulations page of Engraving Options 
allow you to determine whether articulations of force (accent, marcato) or 
articulations of stress (stress, unstress) should be positioned inside or outside slur 
endpoints. 

A new option Position of tenuto relative to tied notes has been added to the 
Ties group on the Articulations page of Engraving Options, allowing you to 
choose whether tenuto articulations should be positioned on the first or last note of 
a chain of tied notes by default. An additional property has also been added to 
allow this default to be overridden for an individual tenuto. 

Beams 

A new option has been added to the Advanced Options section of the Slants 
group on the Beams page of Engraving Options, allowing you to specify whether 
beams containing repeated patterns of pitches should be allowed to have slants, or 
should always be horizontal. 
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Brackets and braces 

A new option has been added to the Approach group on the Brackets and 
Braces page of Engraving Options, allowing you to specify whether groups 
consisting of a single staff should show a bracket. 

Two new choices have been added to the Ensemble type option in the same 
group: British brass band (which provides separate bracketing groups for 
cornets; flugelhorn; tenor horns; baritone horns; trombone and bass trombone; 
euphonium; and percussion), and Big band (which provides separate bracketing 
groups for saxophones; trumpets; trombone and bass trombone; and rhythm 
section). 

Key signatures and accidentals 

 Instruments with (no key) in their names (e.g. French horn, timpani, etc.) are 
now correctly created with no key signatures, and instead show accidentals on 
every note as necessary. 

 An open or atonal key signature can now be created via the Shift+K popover by 
typing open or atonal. 

 It is now possible to change the enharmonic spelling of notes in part layouts 
independently of the full score layout. 

Licensing 

When using a time-limited or trial license, Dorico will now report the time remaining 
in the license at start-up, every 10 days, and every day during the final five days of 
the license period. 

Lyrics 

New Minimum distance from other items option in the Vertical Position section 
of the Lyrics page in Engraving Options provides a small amount of padding 
between items protruding outside the staff and the closest edge of the innermost 
line of lyrics. 

New option to show or hide elision slurs on lyrics in Japanese and other East Asian 
languages by default, in the East Asian Lyrics section of the Lyrics page in 
Engraving Options. In addition, there is a new property to override this default 
setting for an individual lyric. 

Note input and editing 

 A new scissors tool (shortcut U) has been added. Outside of note input, the 
scissors tool will remove any ties in the selected notes and chords. Inside note 
input, the scissors tool will cut any sounding notes in the voice indicated on the 
caret that are sounding at the current caret position. 

 A new option Play notes during note input and selection has been added to 
the General page of Preferences. 
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 New Write ▸ Input Pitch submenu allows you to choose between inputting in 
Written Pitch or Sounding Pitch, which is useful when inputting into 
transposing instruments or when copying instrumental parts. 

Page layout 

 The Edit ▸ Breaks and Edit ▸ Note Spacing menus have been removed, with 
their functions moved to the Engrave menu, in recognition of the fact that 
system and frame breaks can only be created in Engrave mode. New Edit ▸ 
Format Systems and Edit ▸ Format Music Frames submenus have been 
added, containing not only System Break and Frame Break, but also Lock 
Frame, Lock System, Make Into System, and Make Into Frame. 

 The default key command for system break is now Shift+S, and for frame break 
it is now Shift+F. 

Playback 

 A new option Suspend audio device in background has been added to the 
General page of Preferences, switched off by default. When switched on, this 
option releases the audio device when Dorico loses focus, unless it is playing 
back at the time, in which case Dorico retains ownership of the audio devices 
so that playback can continue. 

 Basic playback of changes in playing techniques has now been implemented for 
HALion Symphonic Orchestra, allowing playback of e.g. pizz. and arco 
instructions. 

 The Mixer window now labels each fader with the plug-in output channel and 
the short instrument name, and each fader is also color-coded using the same 
colors used in the track header for each instrument in Play mode. 

 The playhead is now shown in Play mode, and it moves through the music 
during playback. 

Selections 

 Navigating around the music with the arrow keys in Write mode has now been 
substantially improved. 

 Use Tab and Shift-Tab to select the next/previous barline in Write mode. 
 It is possible to start navigation in Write mode without the mouse: simply press 

any arrow key, which will select the first item closest to the top left corner of the 
view. 

 Extending the selection by holding Shift and using the arrow keys now works 
more reliably; hold Ctrl (Windows) or Command (Mac) to extend the selection 
by a bar at a time. 

 Clicking within the staff but not on a note or other item now selects all of the 
music in that bar on that staff; hold Shift and click on another item or a blank 
part of the same or another to extend the selection. 
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 New Edit ▸ Select to End of System and Edit ▸ Select to End of Flow menu 
items, to quickly extend the selection on the selected staff or staves to the end 
of the system or the end of the flow, respectively. In addition, Edit ▸ Select All 
now works as expected. 

 Holding Ctrl (Windows) or Command (Mac) while making a marquee selection 
now adds to an existing selection; holding Ctrl+Alt (Windows) or 
Command+Opt (Mac) while making a marquee selection now subtracts from 
an existing selection. 

 The middle mouse button can now be used instead of Shift to toggle between 
the default action when clicking and dragging, i.e. between moving the view or 
making a marquee selection. 

 Dragging a marquee selection over a barline will no longer select the barline. 

Time signatures 

Hidden time signatures are now shown using signposts, which allows them to be 
selected for copying and pasting, or for deletion. A new View ▸ Signposts ▸ Time 
Signatures menu item allows you to choose whether or not signposts for hidden 
time signatures should be displayed. 

Transposing 

A new Write ▸ Transpose dialog has been added, allowing the selected music or, 
if there is no selection, the entire flow to be transposed. Transposition can be 
specified either by quality of interval (e.g. major, minor, perfect, augmented, 
diminished) or by number of divisions of the octave. The dialog will not allow illegal 
transpositions that would result in notes that cannot be notated (e.g. sharper than a 
triple sharp, or flatter than a triple sharp, or using a microtonal accidental that does 
not exist in the current tonality system). 

In addition, a new Write ▸ Add Notes Above or Below dialog has been added, 
allowing the addition of notes of a given interval above or below the selected notes, 
providing a quick way of building chords over an extended passage of music. 

Tuplets 

Tuplets now show signposts if the tuplet ratio number/string is hidden, which 
allows them to be selected for copying and pasting, or for deletion. A new View ▸ 
Signposts ▸ Tuplets menu item allows you to choose whether or not signposts for 
hidden tuplets should be displayed. 

Vertical spacing 

A new Staff Spacing section has been added to the left-hand panel in Engrave 
mode, allowing you to edit the vertical spacing of the music when switched on. 
Staves can be dragged with the mouse by clicking anywhere in the staff itself, or in 
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the handle at the left-hand side of the system. The whole system can be dragged 
by clicking in the colored stripe immediately above the top staff in the system. 

Hold Alt while dragging a staff or system to also adjust the distance between all of 
the staves and systems below the staff or system being dragged, when there is no 
further room at the bottom of the music frame. 

Use the up/down arrow keys to select the handles at the left-hand side of the 
system; use Tab to cycle between selecting handles for systems and handles for 
staves. Hold Shift and use up/down arrow to extend the selection to the handle 
above/below. 

Nudge the selected staff, staves and/or systems using Alt+up/down arrow, and 
add Ctrl (Windows) or Command (Mac) to nudge in larger steps. 

Use Alt+J/K to nudge the selected staff, staves and/or system such that the 
distance between all of the staves and systems below the staves being nudged will 
also change, once there is no further room at the bottom of the music frame. 

When a staff or system has an overridden position, its handle or the colored stripe 
will be colored red. To remove a specific override, select the relevant handle and 
click Delete. 

To specify an exact distance, click on the numeric read-out in the left-hand margin, 
which allows the entry of a specific measurement, using the preferred units of 
measurement as determined in Preferences. 

To clear all overrides in the selected frame, choose Engrave ▸ Reset Staff 
Spacing. 

To copy the staff spacing from one page to other pages within the layout, click 
Copy Staff Spacing in the Staff Spacing section of the left-hand panel. A dialog 
appears in which you can choose the source page and range of destination pages. 
The staff spacing will be copied if the destination page has the same number of 
systems each containing the same number of staves as the source page. 

If the layout of music within the music frame changes because the music is cast off 
again, any staff spacing overrides for that passage of music will be removed. 

Voices 

 The option Gap between adjacent noteheads in different voices in the 
Voices section of the Notes page of the Engraving Options dialog now 
respects negative values, allowing notes a second apart in opposing voices to 
be positioned more closely together. 
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 New Edit ▸ Voice submenu, containing options to change the default stem 
direction of the voice of the selected note, or if note input is active, to change 
the default stem direction of the voice indicated on the caret. 

VST Expression Maps 

 A new dialog Play ▸ VST Expression Maps has been added, allowing you to 
create and edit expression maps to determine how changes in playing 
technique should be handled by the chosen virtual instrument. 

 VST Expression Maps for Cubase can be imported into your project via Play ▸ 
VST Expression Maps. 

 A new Endpoint Setup dialog has been added, accessed via each entry in the 
VST Instruments panel in Play mode, allowing you to specify which expression 
map is used by each channel on the chosen VST instrument. 

Issues resolved 
The following table lists all issues that have been resolved in this version: 

ID # Issue 

STEAM-4712 
Bars: Using the Shift+B popover to delete bars now also adjusts the position of any time signatures and 
key signatures that are affected by the deletion of bars preceding them. 

STEAM-5129 
Beaming: The behaviour of Edit ▸ Beaming ▸ Beam Together has been improved such that any selection 
that includes a tied note at its start or end will produce the expected beaming. 

STEAM-5040 
Beaming: A problem whereby rests under beams could be positioned incorrectly under some 
circumstances has been fixed. 

STEAM-5003 
Brackets and braces: The options to show sub-brackets and to draw sub-brackets using braces on the 
Brackets and Braces page of Engraving Options now work as expected. 

STEAM-5094 
Brackets and braces: Organ instruments with three staves now correctly show a brace spanning the 
upper two manual staves, leaving the pedal staff unbracketed. 

STEAM-4997 
Brackets and braces: Groups of players created in the Players panel in Setup mode now have separate 
brackets. 

STEAM-4981 Brackets and braces: Staff labels now draw correctly even when partially out of the viewport. 

STEAM-5050 
Brackets and braces: Long staff labels are now automatically wrapped if they exceed half the width of the 
music frame. 

STEAM-5099 
Brackets and braces: Instruments whose names have been overridden are no longer automatically 
numbered. 

STEAM-5119 
Brackets and braces: Saving and reloading a project in which there are multiple groups of players no 
longer incorrectly changes the order of players on reloading. 

STEAM-4944 
Copy and paste: Copying and pasting individual dynamics from within a larger group of dynamics will now 
create new groups containing only the selected dynamics, rather than all of the dynamics from the original 
groups. 
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ID # Issue 

STEAM-4948 
Copy and paste: Items of different types that are either specific to staves or voices are now mapped 
consistently when pasting, so that they don't end up on different staves than expected. 

STEAM-5085 Copy and paste: Attempting to paste an implicit rest followed by an explicit rest no longer causes a crash. 

STEAM-5007 
Copy and paste: When copying and pasting a selection that includes one or more empty instruments, the 
destination passage will also offset the appropriate number of empty instruments. 

STEAM-5027, 
STEAM-5041 

Copy and paste: It is now possible to copy from e.g. the right-hand staff of a piano instrument to the left-
hand staff, provided the source selection contains only material from a single staff. 

STEAM-5030 
Copy and paste: When copying and pasting dynamics, the pasted dynamics are now correctly left 
selected. 

STEAM-4837, 
STEAM-4839 

Copy and paste: Pasting material that includes dynamics or slurs into other staves at the same rhythmic 
position now result in the pasted dynamics and slurs becoming linked to the dynamics and slurs on the 
source staves. 

STEAM-5086 Dynamics: Attempting to set the color of a selected hairpin in Engrave mode no longer causes a crash. 

STEAM-4911 Holds and pauses: It is now possible to add a fermata to the final barline of a flow written in open meter. 

STEAM-5181 
Holds and pauses: A transitory spacing problem that could result in adding a caesura not resulting in 
space being added immediately has been fixed. 

STEAM-5145 Holds and pauses: Fermatas attached to barlines now always draw correctly in galley view. 

STEAM-5116 
Holds and pauses: Fermatas attached to barlines no longer sometimes cause a bar number at the start of 
the system to move incorrectly. 

STEAM-5171 
Instrument changes: Instrument change warning labels now appear correctly when the new instrument 
starts playing on the following system 

STEAM-5167 
Instrument changes: Instrument changes that occur near the start of the flow are now snapped to the start 
of the flow if the first instrument held by the player doesn't play at all before the new instrument starts 
playing. 

STEAM-5160 
Instrument changes: The light blue staff labels in galley view are now shown on each instrument, rather 
than for each player, making it easier to identify which staff is for which instrument held by each player. 

STEAM-5131 
Key commands: Key commands shown in tool tips are now correctly updated when key commands are 
edited. 

STEAM-4672 
Key commands: Setting a key command in the global context now correctly reports if there is a conflict 
with the same key combination in another context. 

STEAM-4985 
Key signatures and accidentals: Attempting to create a new accidental type in the Edit Tonality System 
dialog no longer causes a crash if an existing accidental is not already selected. 

STEAM-5095 
Key signatures and accidentals: The Edit Key Signature dialog now correctly uses the bass F clef rather 
than the baritone F clef. 

STEAM-5057 
Key signatures and accidentals: Custom key signatures that use a newly-created accidental type are now 
shown correctly in the Custom Key Signatures section of the Key Signatures panel in Write mode. 
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ID # Issue 

STEAM-5194 
Key signatures and accidentals: Custom key signatures now show the name supplied by the user as a 
tool tip when hovering over their button in the Key Signatures panel. 

STEAM-5136 
Key signatures and accidentals: Custom key signatures now transpose correctly in layouts set to 
transposing pitch rather than concert pitch. 

STEAM-5028 
Key signatures and accidentals: Repitching notes now works correctly in key signatures that have been 
chosen because they show one fewer sharp or flat than the enharmonic equivalent for transposing 
instruments. 

STEAM-5070 
Layout Options: Saving layout options as the defaults for future projects no longer causes new layouts to 
have either the wrong players and flows or no players and flows at all to be attached to them by default. 

STEAM-4986 
Layout Options: The option Use optical spacing for beams between staves on the Note Spacing page 
of Layout Options is now switched on by default in part layouts in new projects. 

STEAM-5130 
Layout Options: If the saved layout options refer to a non-default set of master pages that is not available 
in the new project, Dorico no longer crashes when creating the project. 

STEAM-5001 
Lyrics: Lyrics assigned to different voices but with the same line number now have the same vertical 
position. 

STEAM-5107 
Lyrics: Lyric extender lines and hyphens now stop correctly before the systemic barline at the end of the 
system. 

STEAM-5065 
Multi-bar rests: Grace notes positioned before a barline now draw correctly if the bar to which they are 
attached becomes consolidated into a multi-bar rest. 

STEAM-5093 Multi-bar rests: Fermatas now correctly cause multi-bar rests to break. 

STEAM-5237 
MusicXML import: Key signatures in MusicXML files that specify a number of fifths but no mode now 
import correctly. 

STEAM-4812 
Note input and editing: Using Space to advance a hairpin past a tuplet no longer engages sticky tuplet 
input, causing subsequent music to be overwritten unexpectedly. 

STEAM-5138 
Note input and editing: It is now possible to create a tied note longer in duration than a maxima, or 64 
quarter notes (crotchets). 

STEAM-5002 
Note input and editing: When using Lock to Duration, the caret now correctly advances to the end of the 
last note in the voice whose notes are being repitched. 

STEAM-4760 
Note input and editing: It is now possible to play chords on your MIDI keyboard when inputting ties with T 
or when Lock to Duration is active. 

STEAM-5072 
Note input and editing: The first note input via the mouse can now have an accidental and a rhythm dot if 
chosen from the panel. 

STEAM-5078 
Note input and editing: Double-clicking to start note input in galley view now always shows the caret at 
the correct location. 

STEAM-5172 
Note input and editing: MIDI step-time input now correctly compensates for the octave transposition of 
the instrument (e.g. piccolo, double bass, guitar, tenor voice), if any. 

STEAM-5188 
Page layout: Graphics placed in graphics frames on master pages are now correctly saved and loaded 
with the project. 
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ID # Issue 

STEAM-5083 
Page layout: A problem that prevented text frames from being deleted in some circumstances has been 
fixed. 

STEAM-5092 
Page layout: Using the formatting commands (e.g. make into system/frame, lock system/frame) in one 
layout no longer incorrectly removes formatting from other layouts. 

STEAM-4984 
Page layout: You can now remove overrides from all pages in the layout by clicking the Remove 
Overrides button in the Pages section of the right-hand panel in Engrave mode with no pages selected. 

STEAM-4886 
Playback: Dorico will now load sounds into all 16 channels of each instance of HALion Sonic SE, rather 
than leaving the final channel in each instance empty. 

STEAM-4496 
Playback: Dorico now compensates correctly for HALion patches that are transposed by one or more 
octaves (e.g. double bass, bass guitar). 

STEAM-4792 
Playback: The playback of hairpins has been improved such that immediate dynamics at either or both 
ends of the hairpin are now properly respected. 

STEAM-4988 
Playback: Attempting to open another project when the Mixer window is already open for the current 
project no longer causes Dorico to hang. 

STEAM-4955 
Playback: The default voice count for HALion Sonic SE in new projects has been increased from 128 to 
512. 

STEAM-4998 
Print mode: A problem whereby staff lines or other lines could appear the wrong thickness on the second 
and subsequent pages of exported PDFs has been fixed. 

STEAM-5098 Print mode: Exporting graphics files from multiple layouts in a single operation no longer causes a crash. 

STEAM-5042 Print mode: The default dots per inch (dpi) value for exported graphics is now 150dpi instead of 72dpi. 

STEAM-5097 
Print mode: Exporting multiple graphics no longer prompts separately to overwrite any found files: you can 
simply confirm that you want to overwrite all existing files at once. 

STEAM-5125 
Print mode: The Watermark text in the Annotations section of the print options panel will no longer be 
cleared incorrectly in the event that multiple selected layouts have conflicting values. 

STEAM-5219 
Print mode: Attempting to overwrite a graphics file that is locked by the filesystem (e.g. because it is open 
in another application) will no longer cause a crash. 

STEAM-4834 
Properties: It is no longer possible to set the values for dot diameter, dash length, and gaps between dots 
and dashes for ties and slurs to zero. 

STEAM-5063 Properties: Properties for X and Y offset for force and combined dynamics now appear correctly. 

STEAM-4570 Rehearsal marks: Rehearsal marks are now correctly centered above double and repeat barlines. 

STEAM-4570 
Rehearsal marks: If the option to position rehearsal marks at the start of the system is chosen, the 
rehearsal marks are now correctly left-aligned with the systemic barline. 

STEAM-5035 
Rests: Rests that have properties set on them, e.g. to force a specific duration or to set a particular staff 
position, are now positioned in a manner consistent with other rests that don't have properties set. 
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ID # Issue 

STEAM-5204, 
STEAM-4848 

Rests: It is now possible to select all individual rests in Engrave mode. 

STEAM-4979 
Selection: A problem whereby the marquee rectangle could be left behind if you hit Esc during a marquee 
selection has been fixed. 

STEAM-5143 
Slurs: A problem that prevented slurs starting in one voice and ending in another from being created 
correctly has been fixed. 

STEAM-4953 
Tempo: The Shift+T popover for tempo input is now much more flexible and will allow a much wider set of 
terms to be input. 

STEAM-5015 
Text: Edit ▸ Reset Appearance now clears any changes of font, size, and other typographical control in a 
selected text item. 

STEAM-5142 
Text: A problem whereby some Japanese fonts were truncated during text editing has been fixed (Mac 
only). 

STEAM-5061 Text: Creating a new text frame on a master page now sets the default paragraph style correctly. 

STEAM-4975 
Text: It is now possible to jump to the name of a specific font in the list of fonts in the text editor popover 
by typing the first letter or two of its name. 

STEAM-5055 
Text: Text frames that are too full now correctly truncate the text within the frame, rather than allowing the 
text to flow outside the frame. 

STEAM-5043 
Text: Copying and pasting text into Dorico from another application no longer causes the formatting of the 
text in the frame to be messed up. 

STEAM-5044 
Text: It is now possible to use the Unicode Hex Input input method to input extended Unicode characters 
into the text editor within Dorico (Mac only). 

 
Text: Paragraph styles in newly-created projects now inherit many of their settings from the Default Text 
paragraph style, making it possible to quickly change the main text font in use in your project by editing the 
Default Text paragraph style. 

STEAM-5154 Time signatures: Newly-created time signatures now correctly show that they are selected after creation. 

STEAM-5207 
User interface: The Layout Options, Notation Options, and Engraving Options dialogs now remember 
which page you were last looking at when you opened the dialog, and show that page when the dialog is 
reopened. 

STEAM-5208 
User interface: A read-out of the current page size using the user’s preferred measurement unit has been 
added to the Page Setup page of Layout Options. 

STEAM-5182 
User interface: The view type selector in the status bar no longer gets out of sync with the actual view 
used when switching layout. 

STEAM-4656 
User interface: When switching between modes, the state of the Hide/Restore Panels button on the 
toolbar correctly reflects which panels will be shown or hidden when clicked for that mode. 

STEAM-5081 
User interface: Dorico no longer crashes when you right-click on a tab and choose to create either a 
vertical or horizontal split. 

STEAM-4978 
User interface: Dorico no longer allows the Mixer or Transport windows to be shown as full screen 
windows (Mac only). 
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ID # Issue 

STEAM-4956 
User interface: The buttons on the toolbar to hide or show the Mixer and Transport windows now correctly 
reflect whether or not the Mixer and Transport windows are actually shown. 

STEAM-4908 
User interface: When closing the final project window and the Steinberg Hub is set not to reappear, the 
menus no longer disappear (Mac only). 

STEAM-4528 
User interface: New Write ▸ Create Voice and Next Voice menu items, intended to make the Shift+V 
and V key commands for use in note input more discoverable. 

STEAM-4039 
Zoom: The behaviour of zooming in when the selected item is close to the edge of the viewport has been 
improved. 

STEAM-5166 
Zoom: A problem whereby Dorico could crash when switching window mode when the zoom level is set 
to Whole page has been fixed. 

STEAM-5089 
Platform support: Dorico now uses DirectWrite to render all text and glyphs in its user interface, which 
should resolve the problem with icons appearing stretched or out of proportion until Dorico is restarted 
(Windows only). 

STEAM-4992 Localization: The names of templates that appear in the Steinberg Hub are now localised. 

STEAM-5305 
Localization: Typing characters that require the use of the Alt modifier (e.g. [, ] and |) into popovers now 
works correctly on non-English keyboards.  

STEAM-5312 
Localization: A number of problems with keys that produced accented characters when specifying key 
commands in the Key Commands page of Preferences have been fixed. 

STEAM-4893 
Localization: The handling of key commands in the Japanese language version of Dorico has been 
overhauled. 

STEAM-5310 
Localization: Changing the keyboard language on the Key Commands page of Preferences now takes 
effect immediately, rather than requiring a restart of Dorico. 

STEAM-5313, 
STEAM-5314 

Localization: The default key commands for French, Spanish, Italian, and Portuguese have been revised in 
relation to the various keyboard handling fixes. 
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Dorico 1.0.0 

October 2016 

Initial release version. 
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Known issues and solutions 

Frequently asked questions 
Answers to frequently asked questions about Dorico can be found online in the 
Dorico forum. 

Knowledge base 
For the latest information about issues and solutions you may encounter when 
running Dorico, please consult the Knowledge Base. 

Entering the eLicenser Activation Code (Mac only) 
When you first run Dorico and are prompted to enter your Activation Code, you 
may find that after you have successfully activated your Soft-eLicenser, you must 
quit and restart Dorico for the application to detect that it is fully licensed. 

Key commands to transpose notes by an octave (Windows only) 
The Intel Graphics Adaptor drivers used by many Windows computers define a 
default key command to flip the screen by 90, 180 and 270 degrees via a shortcut 
Ctrl+Alt+up/down/left/right arrows. 

Ctrl+Alt+up/down option conflicts with the key commands in Dorico note input for 
transposing notes by an octave. 

For information about how to disable the default Intel Graphics Adaptor key 
command, consult the Knowledge Base. 

Audio export 
No progress dialog appears on Mac during audio export. A busy cursor will appear 
for the duration of the export operation. Check that the operation has completed 
successfully before you try to play back the exported audio file. You can verify that 
the export has completed successfully by checking the file size of the exported file: 
if it is reported as 0 bytes, the file is still locked for writing. 

Arpeggio signs 
Arpeggio signs on different instruments at the same rhythmic position will all be 
positioned to the left of the widest extension on any chord at that rhythmic position 
on any staff, so they may appear further left than necessary on some staves. This 
will be addressed in a future update.  

https://www.steinberg.net/forums/viewtopic.php?f=246&t=104450
https://helpcenter.steinberg.de/hc
https://helpcenter.steinberg.de/hc
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